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Introduction

Control systems for large scientific and industrial facilities are highly complex
systems. They control hundreds or thousands of devices of many different types,
through a variety of interfaces. Good monitoring and control is mission critical to
these facilities.

The TANGO control system is a free, open source control system that is being
collaboratively developed between the ALBA, ANKA, DESY, Elettra, ELI-BEAMS,
ELI-ALPS, ESRF, FRM I, INAF, MAX-1V, Solaris and Soleil Institutes, with the
specific aim of managing this complexity in a contemporary and powerful
fashion.

Tango is object-oriented and distributed. This makes it both flexible and
developer friendly.

The purpose of the Tango Box Virtual Machine is to give you a fast, out-of-the-box
experience of a working Tango system. There is a limited set of shortcuts to
essential Tango tools on the virtual machine desktop. Together with the
introductory movie video and this user manual, they allow you to experience the
power and elegance of the Tango system first hand. After this "guided tour" of the
Tango system, Tango Box is an excellent tool to make further explorations on your
own, to use it for demonstration purposes, to make studies, proof-of-concepts and
the like. This way, out of this little box, another great, sophisticated control
system for the real world gets maybe born!
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Overview of Tango (Box)

TANGO consists of a number of main parts: one is a software bus, or TANGO
kernel. It is a system that lets TANGO clients monitor and control equipment
through TANGO device servers. This communication between clients and servers
can be both synchronous, asynchronous or event driven.

Another part is the central services. A configuration database contains all
configuration data (runtime attribute and property values that differ between
instances of the same device type/class, do not belong in code, and need to be
managed in central repositories for these large systems to be maintainable). An
archiving service allows historic values of the attributes to be stored and
retrieved. A snapshot tool allows a system state to be saved to persistent
storage and to restore that state to the machine. An alarm system signals
parameter values approaching or reaching values outside normal operating
ranges and potentially damaging to the machine. Finally a diagnostic logging
system logs diagnostic messages for later analysis.

A third major part is a set of tools that allow administration of the TANGO system.
It is through these tools that we will experience the running TANGO system on
the Tango Box VM. Jive is TANGO's database browser, providing hierarchic
access to TANGO's Servers, Devices and Classes. Astor is the Tango Manager for
controlling, starting and stopping TANGO device servers. AtkMoni is a tool for
charting and monitoring device variables (attributes). A complete list is in Table
1: Summary of key TANGO Box tools.

A set of tools worth mentioning in its own right is Sardana. Sardana is a
standard generic user environment built on top of TANGO, specifically for
realizing control applications that require sequencing of fast and slow controls,
e.g. beamlines and their experiments. It is exposed through the Spock and
iTango shortcuts on the Tango Box desktop.
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Setting up your System
Installing VirtyalBox .

Installing Virtual Box

TANGO Box is a virtual machine that is based on the Ubuntu operating system
and the easiest way to run TANGO Box is to use Virtual Box which allows you to
run images of different operating systems on your existing system. Download
Virtual Box (https://www.virtualbox.org/wiki/Downloads) and install according to
the instructions provided.

-

Downlo_ad

Download TANGO Box

The TANGO Box image which is run in Virtual Box can be downloaded from the
TANGO website TANGO Box V9.0 http://sourceforge.net/projects/tango-cs/files/).

Note: The extraction from the archive can take several minutes.


https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
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Running TANGO Box

006 oradevmMvituspoxManager |
& B @ <

N Setti Start [ i |@ Details | ® Snapshots
ew etlings arl Discard

‘?"ﬁ an /m & General E Preview

Name: tango9-vm
Operating System: Ubuntu (64-bit)

[# System

Base Memory: 4096 MB
Boot Order:  CD/DVD, Hard Disk
Acceleration: VT-x/AMD-V, Nested Paging

Display @
Video Memory: 12 MB

Remote Desktop Server: Disabled

Video Capture: Disabled

Storage

Controller: IDE
IDE Primary Master:  [CD/DVD] Empty
IDE Secondary Master: [CD/DVD] Empty
Controller: SATA
SATA Port 0: tango9-vm.vdi (Normal, 1,00 TB)

e Audio

Host Driver: PulseAudin

Figure 1: Virtual Box opening screen

1. Launch Virtual Box = New Virtual Machine.

2. Choose Linux, Ubuntu 64 bit and name e.g. tango9 :

X Create Virtual Machine

Name and operating system

Please choose a descriptive name for the new virtual machine
and select the type of operating system you intend to install on
it. The name you choose will be used throughout VirtualBox to
identify this machine.

Name: tango9
Type: Linux = @J
Version: | Ubuntu (64-bit)

k

k

'Hide Description | < Back [ Next> | | Cancel |
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3. Select settings according to your machine - recommended memory
setting of 4 MB

4. Select the disk image you download and unzipped - tango9-vm.vdi:

Hard drive

If you wish you can add a virtual hard drive to the new machine.
You can either create a new hard drive Ffile or select one from
‘ the list or from another location using the Folder icon.

If you need a more complex storage set-up you can skip this
step and make the changes to the machine settings once the
machine is created.

The recommended size of the hard drive is 8,00 GB.
O Do not add a virtual hard drive
() Create a virtual hard drive now

@® Use an existing virtual hard drive file :

tango9-vm.vdi (Normal, 1,00 TB) |

R (
<Back | Create | Cancel | 1

5. Start the TANGO9 Virtual Machine and discover the wonderful world
of TANGO9 :

1ty B = «) 1145 1

user = tango-cs

README

eI Demo

ol WO U@ NS AEFONIMBA:

OpPE=@ @ ERight Ctrl
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Whetting your Appetite

Quick Out-of-the Box Experience
Experiencing a TANGO System running a Motor Simulator

1. Launch Jive from the Desktop.

Jive 4.31 [tango9-vm:10000]

user = tango-cs
pw = tango

SardemoGur

README

e Tango

AtkPanzl TaurusG( class | Alias | Att. Alias | Property | Device Info
Server £ Device T

H ¢ & HdbArchiver i sin/motor/1
,& HdbArchivingWatcher e_id: I0L:Tango/Device_5:1.0
r HdbExtractor
iTango > 3 HDETDBArchivingWatcher
¥ LimacChs SinMotor/test

o % Linac 2317
¢ & LinacMediumLevel
o= & LinacSequencer 11th October 2015 at 11:43:53
@%Macmserver 7th October 2015 at 16:20:56
< 4 Modbus
* & Pool
T 4 Eydlarm Polled command name = State
% % PySignalSimulator Polling period (mS) = 100
o & simCed Polling ring buffer depth - 10
9 % simMotor or the last commands (Position + InstantSpeed +

¢ test Data not updated since 73 mS

¢ & simMotar Delta between last records (in nS) = 160, 100, 100, 100

> & Simiimof o Polled attribute name = Position
o & sim/mot Copy Pelling period (nS) = 100
o & sim/mot Paste 7l m
& & simurelay Rename
i s

Jlinac &

Monitor device

12
tangeg-vn (10.0.2.15)
45438

- POLLiNG Status === --=ns-ssmmssomosoomsooeios

Mambo.
iambo

Define device alias
Go to device node
Restart device
Device wizard

) L ]
[@l| Connecting things together

ROop@PaEwm@d @G Right Ctrl

Figure 3: Jive screen showing hierarchy of device server (SimMotor), device server
instance (tangobox), device class (SimMotor) and device class instance (sim/motor/1)
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2. Click on SimMotor -» TANGObox.
3. Right click on sim/motor/1 and select Monitor Device.

4. Repeat above to open a second “Monitor Device” window for
sim/motor/1.

5. This opens the auto-generated device client.

1 ©) 1024AaM {3

Q. PWD: guest_test

@ W ¥

File Edit Tools Filter

Device Info

AtkPanel 4.4 : sim/motor/1

*‘E’E).ataBased File View Preferences Help
o % LimaCCDs

e oo [ ]
o 8 <
¢ g:ﬁﬁ;ﬂf\m sim/motor/1
¢ % tangobal [Pevice is OK =
¢ &l simM
o= <5 sil
o= 48 sil |
o= 48 sil
o % Starter

File View Preferences Help
sim/motor/1

Device is OK o

8
F
=
2]
o

up limit switch state [ ]

Home_side []

Instantaneous speed | 0.00 mm/s
Scalar
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up limit switch state []
Home side []

Instantanecus speed | 0,00 mm/s

o % TangoAcces| Rialii
@ o % TangoTest StepSize [10.000 mm 005 . 00 [] StepSize |10.000 mm 000.00 ||
A AR RIS TYY YV
® FYYYYVYS FYVVYY VY
- Steps | 500 steps 000500 Steps | S00steps 000500
“ ‘ . P2 S3y3vY ld E | e =
j——
AAAA Ad Abbd Abd
: position | 5.000mm | 0005 .000 D position | 5.000mm 0005 . 000 E|
XYY B0 TYXY XYY
=l low limit switch state [ ] El low limit switch state [ E|
|
i =

Figure 4: AtkPanel showing attributes for sim/motor/1. The position of the motor can be
changed by using the controls indicated by the blue arrow.

6. Change the motor position using the controls indicated by the blue
arrow.



File Edit Tools Filter

Class [ Alias Proper‘ty|

;| Device Info

o % MacroServer
o % Pool
o % PySignalSimulator
¢ % SimMotor
¢ % tangobox
o & SimMatar
o & sim/motor/1
o & sim/motarf2
o & sim/motar/3
o % Starter
o ﬁ‘TangoAccessControl
o vTanguTast

Server Device
o % DataBaseds
o % |imaCCDs

- Device Info

Device:
ltype_id:

H|/iiep_version:
il lhost
i lport :

IServer:
iServer PID:

o [Exported:
il [Last_exported:
|/l ast _unexported:

- Polling Status

@ﬁﬂﬂﬂd@

File View Preferences Help

I sim/motoril

sim/motor/1

Device is OK

[

1]

AL

. : Ad
| StepSize [10.000 mm 00
iy

Ah

Steps | 600 steps 00

¥y

o AAA

position | 6.000mm  ©00

Yy

low limit switch state []
up limit switch state []
Home_side []

A Chnn e

-
<O <O O
O <O <O

~Op-

JEIEIE] B B OB

R b i e

D

4]

I
| scalar |

sin/motor/1
I0L:Tango/Device_4:1.0

1.2

tangobox.local [192.168.149,151]
58763

SimMotor/tangobox

2968

true

28th June 2013 at 10:17:26

6th June 2013 at 22:31:47

EEEECEIEE]
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1y «)) 11:00AM {i

PWD: guest_test

¢ 3 Trend

¢ [ sim/motor/1

m position

al
10:55:00

10:56:00 10:57.00

position (Y1)

--- position [Max alarm] (Y1)

10:58:00 10:59:00
--- position [Min alarm] (Y1)

Figure 5: AtkMoni (Trends) showing the trend over time of the Temperature attribute for

sim/motor/1.

7. You can view how the motor position is changing by launching

AtkMoni. Click on Add New Attribute (toolbar button

) and select

]

in the tree: sim -» motor » 1 - position. Then right-click on the
position attribute and choose "Add to Y1".

Monitoring (toolbar button

=

Then click on Start
). Now, if you change the position in

Jive, you can see the position change in AtkMoni.
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13 ) 10:40AM I

® _—st
IW File Edit Tools Filter File View Preferences Help

Class | Alias | Property | Attribute configuration [sim/motor/2]

Server Device || [ Display [ Unit | Range [“Alarms | Description | I sim/mator/1 |:|z| ‘

—J
p o % DataBaseds H Attribute name Label Format i
o % LimaCCDs i |acceleration Accelera... [%4d =
| o % MacroServer Backlash [%5.3f Pevice is OK B

[first step... |%4d
up limit s... %86, 2f
low limit ... [%6. 2f =

o % Pool
o & PysignalSimulator
¢ % SimMotor

¢ % tangobox

Home po...|%7.3f

¥ > ]

¢ & SimMotor Home side %6, 2F R R E
[ o ¢ sim/motor/l 4 Instanta... [%6. 2f ‘ AhA AA
¢ & sim/motar/2 b position  |%7.3f StepSize [10.000 mm 000 .00
o B8] Properties Preset P... [%.3f A AA
Polling State %6, 2f AALALA
E E& Event Status %6, 2f Steps | 500 steps 000500
{5 Attribute config Steps 266d A
- By e properties Steps_per_unit Steps pe...|%7.1f N AAAA AAA
i epSiza spoize 1% position | 5.000 mm 0005 . 000
e A AR A

- An interactive client. low limit switch state ]

up limit switch state []
Running on top of Python 2.7.4, IPython 0.13.2 and PyTango 8.0.3

EIEEEI B B B

|”-| Home_side []

- -> ITango's help system. Instantaneous speed | 0.00 mm/s
- -> Details about 'object'. ?object also works, ?? prints more.

» Scalar

™

IPython profile: tango

1 PyTango.DeviceProxy("sim/motor/1").position

Figure 6: iTango terminal
1. Launch iTango

2. Enter (copy) the command into the iTango console.

Motor can be seen to be moving in the ATKPanel.

When typing, try pressing <tab>. Since /Tango has
autocomplete embedded you get a list of possible
completions. Example:

) PyTango.Release.<tab>

TIp

Gets a list of all members of PyTango.Release class. Equally:

PyTango.DeviceProxy ("sim<press tab key>

Gives a list of available runtime options
sim/motor/1 sim/motor2 sim/motor3
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We put the command in line of Python code to save you a
copy-paste.
Note The following works equally well of course:

motorl = PyTango.DeviceProxy ("sim/motor/1")
motorl.position = 4

As we will see further, Taurus is a library to create GUI's for the TANGO system in
Python. It comes with a collection of demos. We will use one of them as a starting
point for this demo.

In a new terminal window type:
| taurusform sim/motor/1 I

This launches the form below, which provides again access to the various motor
attributes. We leave it to the reader to explore the GUI, change values and
observe the synchronization via the TANGO device server of these two TANGO
device clients: the ATK-based monitor panel and the Taurus based form.
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sim/motor/1

SIM/MOTOR/1 (|
8 state [INGN ©
Attributes | Commands
Acceleration [0l | 10| stepsfsh2 |
Backlash 01000 | 0.000 | mm
first step velocity I | 0  steps/s
up limit switch state ™ ]
low limit switch state o
Home position 00 0.000 | 0.000 | mm
Home_side ]
Instantaneous speed I 000 mm/s
( position] 6000 | 5.000 | mm
( Preset Position] [ 0:000] | 5.000 | mm
Stepsize [N0:000 | 0.000 | mm
Device is OK
i m y ¥ .

Figure 7: Taurus Form for sim/motor/1
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JDraw is the TANGO synoptic editor. You can use to construct (draw) synoptic
screens, i.e. GUI's with graphical representation of the physical layout of the
device to be controlled by TANGO.

1. Launch /Draw

JDraw Editor 1.13

o= controller

o= Door

o= [ dserver

o [ expchan

o [J LimaccDs

o [ MacroServer
o I mntgrp

o= [ motor

= CIpm

o= [ Poal

o [ PySignalSimulator
o= [ sim

oI sys

o= [Jtango

o= Jtest

File Edit Create Views Tools

BII‘ “SIC’I‘ %I EI I!I‘ E*I - I 100% ‘m‘dla %IFI EIIDIEI

q Il [To]

[4]

2. Open the file synoptic demo.jdw.
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Look In: |[Jquest |" E

es C] Taurus O www

go Ctmp [ core

na Jtools |D synoptic demo.jdw |

CJvideos

_classes CJvmware-tools-distrib

BoxGui CJworkspace

1] [ Il [»

File Name: |synoptic demo.jdw |

Files of Type: |All Files v
| Open | ‘ Cancel ‘

You see a graphical representation of a beam line with its optics elements. To
provide a live demo of TANGO synoptic screens, the right-most slit is already
associated with the State of our sim/motor/1 from the previous examples

3. You can see the associated object by double-clicking on the slit. The
Object name field in the dialog that opens reads: sim/motor/1/State.

1y 4) 10:33AM

JDraw

@ Eile Edit Create Views Tools
?) & 9 controller EI”«;I@” %IEI‘H” ;;:l;{lmu% | I@Iﬁ]‘ﬂaélml EI.E,IHI
Al > 7 Door
— | JE=he OPTICS HUTCH 1
o3 expchan
p o 9 LimaCCDS
| o~ O3 MacroServer A
BUUJER = Pproperties [1 JDGroup selected] 7
e Sitm m g
| Graphics | Value | Extensions
% Object name XBP y I
— |5|mfmutorflfstate || Apply ‘ & ¢ Pindiode
W Screen

’} fiad] | Mirror " garmanium

Foreground - Background I:l Sequencer HDEB Storage

4 1 n

~ = N
=—.- Line style = Line width OE

Fill style  [No fil [=] [ cradient settings |
_—
i [¥] visible [ Anti alias
— Shadows
& []shadow Cinvert Thickness 1E|

Dismiss

4. Before we go to live view let us associate the leftmost slit (slit2) as
well with a motor: sim/moter/2. Double-click it and type in Object
name: sim/motor/2/State and click apply

5. Go to Views -> Tango Synoptic view. Now if we change the position
of any of both motors in ATKPanel, we see that the slit in the
synoptic view indicates that a movement (blue color) is occurring.
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AtkPanel 1 ) 1037AM I

Eile Edit Create Views Tools

o [J controller
o 9 Door
o= ] dserver

o [ expchan

o= g LimaccDs

o I MacraServer

File view

OPTICS HUTCH 1

e View Preferences Help

o Faal o simmetorn | ||

o [ PySignalSimulator Sgtitty
o= 3 sim sim/motor/1 snutter

o sys Device is OK B
o [Jtango A brage
& CTtest ¢ Findiode |
=
Mirror " germanium creen —

P

Sequencer HDB Storage

; ; . 2
F Abd Ah Screen - -
StepSize (10.000 mm 000 .00
:- 2 IV T7 =
FYY VYV
1§ Steps 000758
FITITT
U " Abhh Ah
position 0007 .580
YYYY 77

low limit switch state []

up limit switch state []
Home_side []

Instantaneous speed ’m

Scalar
|

CIEIEIE] B B E
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TANGO Box Tools Overview

Now that you have had a taste for running TANGO, we can examine some of the
tools that are packaged with TANGO. These tools have shortcuts on the desktop
and are summarised in Table 1.

Table 1: Summary of key TANGO Box tools

Tool

Purpose

Astor/Start The Astor/Starter pair of applications will help you to administer

er

ATK

ATKPanel

ATKMoni
Eclipse

iTango

JDraw

Jive
Netbeans
Pogo

Spock

TaurusDesi
gner

your control system (Starting/Stopping device server, checking
them, etc.). Astor is a graphical application and Starter is the
name of the device server used by Astor.

TANGO Application ToolKit (ATK) is a java graphical layer for
building GUIs for TANGO.

ATKPanel is a generic application which displays panels allowing
you to execute any device commands or to read/write any device
attributes

AtkMoni is the tool to view how your data is changing.

Widely used development environment

iTango is a PyTANGO CLI based on IPython. It is designed to be
used as an IPython profile.

Synoptic editor to draw your synoptic(s) to control TANGO devices
(To be used with ATK)

The TANGO database browser and device testing tool
Alternate development environment
Allows you to create/update TANGO device classes in C++

Spock is an iTango based CLI (command line interface) for
Sardana.

Spock has been extended in Sardana to provide a customized
interface for executing macros and automatic access to Sardana
elements.

Powerful TANGO client GUI designer. It is a Qt designer application
customized for taurus
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The Elegant TANGO Architecture: A Quick

Overview

Java, C++,Python Linux, Windows, Solaris
MATLAB e
2% L -
| | l TANGO Software Bus

=

rrrrrrr

-

Linux, Windows, Solaris \\]r, Labview RT .

Figure 8: Overview of the TANGO Architecture

The following provides a short description of the main architectural elements of
the TANGO system to provide the system context. In the next chapter we look
into more detail into those elements that are most relevant to the
programmer/user of the TANGO system: the OO aspects.

TANGO is based on the concepts of object oriented and service oriented
approaches to software architecture. The object model in TANGO supports
methods, attributes and properties. In TANGO all objects are representations of
devices.

TANGO is primarily used to provide network access to hardware. Hardware
access is programmed in a process called a Device Server. The device server
implements device classes which implement the hardware access. At runtime the
device server creates devices which represent logical instances of
hardware. Clients "import" the devices and send requests to the devices using
the TANGO protocol.

The object model in TANGO supports methods, attributes and properties. In
TANGO all objects are representations of devices. The devices can be on the
same computer or distributed over a number of computers interconnected by a
network. The network communication is done using CORBA. Communication can
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be synchronous, asynchronous or event driven. Configuration data is
stored in a database. Programming support is provided for C++, Java and
Python. Clients can be written in all three languages. Servers can also be written
in C++, Java or Python. TANGO provides a kernel APl which hides all the
details of network access and provides object browsing, discovery and
security features.
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Some ready to use graphical applications (DeviceTree, ATKPanel, ...) allow you
to graphically display data coming from your device(s). Graphical layers above
the kernel API have been developed to reduce specific graphical client software
development time. One exists for Java SWING (ATK), another and another one for
Python PyQt (Taurus).

TANGO uses CORBA (synchronous and asynchronous communication) and
zeromq (event based communication) and is a distributed control system that
can run on one or many machines.

TANGO uses the omniorb implementation of CORBA as its network protocol. The
client-server model is the basic communication model. Communication between
clients and servers can be synchronous, asynchronous or event driven.


https://www.tango-controls.org/static/taurus/latest/doc/html/index.html
https://www.tango-controls.org/download/index_html#atk
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TANGO is Programmer Friendly!

It is Object Oriented

TANGO wuses concepts (& constructs) from object oriented programming
languages to help manage the inherent complexity of large control systems.

For example there will be many instances of the same piece of hardware
equipment in the entire system, for example magnet power supplies. Where at
runtime the currents they supply will be different, they obviously share many
properties that are the same (e.g. you interface to them in the same way). In OO
this static commonality is captured in a Class and the differences in run-time
objects or instantiations of that class. That is exactly what TANGO provides for us.
TANGO Device Classes and TANGO Device Instances. The SimMotor that we
saw in the Wetting Your Appetite chapter is an example of a Device Class,
"sim/motor/1", the name of a Device Instance.

Being able to build hierarchies of things (objects) of specific types is another
powerful concept of the OO world. A TANGO system has such a hierarchy and it
supports its distributed nature. Here we introduce the concept of a TANGO
Device Server (DS). Essentially the DS is the process in which Device Instances

(of Classes) are running. The TANGO system allows setting it up in this flexible
way:

A Tango device server
LimaCCDs/simulator

Tango device class
LimaCCDs

Tango device class
LimaTacoCCDs

- -

-
~

e ~
P ~

Device

AY

4 .
7 Device '\

] ;o \ Device / Device \\‘

anaCCDs/ ; L]_maCCDS/ ! limaceds/ H limaccds/ t

smlullator/ ' simulator/ K limatacoccds/ ‘\ limatacoccds/ !
N 2 v

~ s
~ -
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So, one Device Server (process) can run multiple instances of multiple device
classes!

(Note: the dotted line around the second instance is because in your Tango Box,
there is only one instance at start-up, but there could be more)

If we apply this to our example of the multiple power supplies, we see TANGO
offers us many ways to set up this system, depending on the physical layout and
other parameters of the machine. If two power supplies are close to each other,
we can control them from one PC (crate), with one device server process, or with
two device servers, on the same host machine. If they are far from each other,
we could control them with two device servers on two separate host machines.
TANGO is not putting any restrictions on our system configuration here. And for
the TANGO clients, this is all transparent. An important consequence is also we
can redesign the physical layout of the system, without a big impact on the
software clients.

Device Attributes, Properties, Commands and State

Encapsulating data and behaviour into single entities is another important OO
concept; it is an improvement over how you can model, represent the real-world
in your code, compared to older programming techniques.

TANGO uses these concepts to represent the physical equipment the system is
controlling. But as we will see it goes beyond having the data in data members
and the behaviour invoked through methods: A Tango device class has additional
provisions that are essential in the domain of control systems.

First there is the distinction between attributes and properties. In general OO
terminology they are used interchangeably. In TANGO, the attribute is used to
represent process variable, physical values like current, voltage, temperature, ...
they are supposed to vary continuously. Properties are much more static, they are
the things you need to set up once for the software device to work, to connect
properly to the physical equipment etc. Typical example is a IP address.

Attributes have a set of domain-specific meta-data. Just to name a few important
ones: the physical unit (Ampere, mm, ...), range values, alarm values.

Commands are the "dials and knobs" of the device. In a distributed system it is
essential that you can distinguish between synchronous and asynchronous calls.
TANGO supports that.

A last OO concept we mention is the "state" of the class, i.e. technically is that
combined values of all data members. In control systems it is worth to be more
specific, to model devices as state machines with a set of predefined states and
transitions between those states. TANGO provides that: by default, TANGO
classes have a state attribute for this purpose and there is a set of predefined
states: ON, OFF, OPEN , CLOSE, MOVING, ...
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Let us conclude the brief introduction on the OO concepts used in TANGO here.
The TANGO architecture relies heavily on more advanced concepts and
techniques of the OO world, such as design patterns, but a discussion of this is
outside of the scope of this VM User Manual. Please refer to the following sources
for more information:

Abstract device pattern and Tango, A.Go6tz e.a.

Tango Control System Manual v 8.1: 8.1.2 The Device Pattern

Python powered tools: iTango, Sardana & Spock

Programmer friendliness is also greatly enhanced if you can interface dynamically
with a system through an interpreted, high-level programming language such as
Python.

Simple and powerful GUI building

Taurus Designer is a powerful TANGO client GUI designer. It is based on
QtDesigner, and extended with additional Taurus widgets and functionality to
serve for the purposes of TANGO development. With this tool, it is possible to
assemble and configure a TANGO client GUI, without the need to modify the code
itself.

In this section, we will construct such a simple client that will include most
common Taurus widgets for extracting and writing data from and to a device.

1. Open Taurus Designer by typing in a terminal window:

2. Create New Form

In the first window, you can select a type of the form that will be used. You
can choose from preassembled templates, widgets or any custom user
widgets. In the “templates/forms” section, select a “Widget” and create it.

3. Adding a new Label for Title

A standard Label is used for displaying a String. On the left, in the “Widget
Box” section, under “Display Widgets”, you will find a “Label” widget. Drag it
onto your form. Position it, double click it and set the string to display a
desired message/title. In the property editor on the right, you can modify it
furthermore. Change the “objectName” to a meaningful name, e.g. "title" and
modify the font, e.g. to font size 14.


http://www.esrf.eu/computing/cs/tango/tango_doc/kernel_doc/ds_prog/node9.html#SECTION00912000000000000000
http://www.tango-controls.org/device-servers/abstract-classes/Abstract_Device_Pattern.pdf
http://www.tango-controls.org/device-servers/abstract-classes/Abstract_Device_Pattern.pdf
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Dwe B o
Widget Box
label
Display Widgets
() Label
Taurus Display
‘Q TaurusLabel
Qwt Widgets

SR NELE: -
0@ . EeTTTOn T =

Eim Motors

Object Inspector ®
Object Class
v 5% Form [2] Qwidget
title " QLabel
Property Editor (€3]
mp- =

title : QLabel
Property Value

objectName title

|

enabled
» geometry [(140, 20), 91 x 17]
» sizePolicy [Preferred, Preferred, 0, 0]
> minimumsize 0x0
» maximumsSize 16777215x 16777215
> sizelncrement 0x0
» baseSize 0x0
palette Inherited
¥ font A [Ubuntu, 14]
Family Ubuntu
Poink Size 14
Bold

Ikalis &

4. Attribute Readout

Create a new Label for displaying the name of the attribute.

Create a new TaurusLabel for displaying the actual value of the attribute. You
will find it in the Widget Box under Taurus Display. Drag it onto the form. In
order to connect this field to an actual device, all you have to do is to specify
the device and the attribute. In the Property Editor, change the value of
“model” to “sim/motor/1l/position”, where “sim/motor/1” defines a device and

“position” defines the attribute of the device.

‘© Qt Designer ]

DB |

[E& TaurusattrForm
Taurus Views
Taurus Buttons

(> Taurusta...erButton
E‘] TaurusCo...ndButton
E] TaurusLockButton
Taurus Input
E TaurusValueSpinBox
## TauruswheelEdit
8 TaurusModelList
TaurusValueLineEdit
TaurusCo...LineEdit
8 Graphica...cewidget
TaurusV...omboBox

p—y

Widget Box ®

O HBRE T EEYL

Sim Motor

position: m

Object Inspector ®
Object Class
v 5 Form [Z] Qwidget
label " QLabel
ta...el © TaurusLabel -
Property Editor ®
e = S

taurusLabel : TaurusLabel
Property Value
» textinteractionF... TextSelectableByMouse|LinksAccessibleBy...

lel @u‘motcrfﬂpositioﬂ I
ranslatable &
disambiguation
comment
useParentModel

sim/mator/1/position

5. State Indicator using TaurusLed

Create a new Label for displaying a name of the attribute (State).

Create a new TaurusLed. In the property Editor, change its value of “model” to
“sim/motor/1/state”, where again “sim/motor/1” defines the device.
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6. Status Readout
Repeat the “Attribute Readout” part for an attribute “status”
7. Attribute Input

Here, you will create a spin box, used for writing a value to an attribute of the
device.

Create a new TaurusValueSpinBox (first of the Taurus Input widgets). In the
Property Editor, change its value of “model” to “sim/motor/1/position”, where
“sim/motor/1” defines the device and “position” defines the attribute.

8. Command Button
Here, you will create a button that will execute a command on the device.
Create a new TaurusCommandButton. In the property Editor, set the value of
“model” to “sim/motor/1”. This defines a device. Change the value of
“command” to a name of a command, for instance “StepDown”.

9. Generate Code

After saving the *.ui file in the designer, execute the command for generating
the python code.

| ¢d /ProjectPath |
| taurusuic4 -x -o ui_ name.py fileName.ui |

11.Testing the client

If everything was properly set, your GUI client should look similar to:

Sim Motor Sim Motor
StepDown StepUp StepDown StepUp
State: O State: 0
Status: ‘Device is OK. Status: Device is OK
Position: 5000 ( soo00 : Position: 9.220 6.000 >

Try changing the position. Execute commands using buttons. Validate if the
position, State and Status are properly read and displayed.
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Putting it into Practice: Writing a Simple

Device Server

Let us dive a bit deeper and create an actual Tango Device Class and Device
Server in C++, using the Pogo code generator.

For this example we will be creating a simple temperature sensor. Start by
launching Pogo from the Desktop.

Enter the data as in the screenshot
1. Enter Class Name (MyTemperatureSensor)
2. Project Title (idem)

3. Class Description (idem for this demo. In real world applications please
describe the class behaviour here in detail)

4. Fill in Device Class Identification information (not filling them won't
allow you to OK the dialog)

5. Click on Ok.

Class Definition Window

{Class Name : MyTemperatureSensor

| Add Inheritance Class ‘

. e e e 5;
Device Class Identification elp ILanguage : B B © Eifie

Project Title : [MyTemperaturesensor |
Contact email * [iohn.doe@tango-controls.org | :|class Description:
MyTemperatureSensor -

Class family * |Acqui5itian

Bus * |Not Applicable

=
Platform * |AII Platforms |v‘
=)

Manufacturer |nune | ki

Product Reference

Figure 9: Class Definition Window

Next we will add a Scalar Attribute that will represent our physical value we want
to measure: Temperature. All the default values (type double, read-only, etc.) are
ok for our example: click OK.
Now we can generate our C++ files. Click File>Generate or ctrl-G.

% Set Output path to /home/guest/MyTemperatureSensor

% Select Linux Makefile, so we can easily build the project
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Generation Preference Window

Browse

Output Path: |/home/guest/MyTemperatureSensor|

Files to be generated :

Device Class: w XMl file ® Code files

Linux: ® Makefile

Windows: {2 VC8 Project (0 VC9 Project ) VC10 Project
Documentation: ) html Pages

Figure 10: Scalar Attribute creation and Generation Preference Window

Launch terminal

In the bin directory there is an executable MyTemperatureSensor executable. This is
a device sever. Run the device server with an instance, msti, in this case:

| ./MyTemperatureSensor mtsi I
L

However, the device server has not been registered so you get an error message.

guest@tangobox:~/MyTemperatureSensor/bin$ . /MyTemperatureSensor mtsi
The device server MyTemperatureSensor/mtsi is not defined in database. Exiting!

guest@tangobox:~/MyTemperatureSensor/bins I
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Launch Jive and go to the Server Wizard to register the device server
(MyTemperatureServer) and its instance (mtsi).

File Edit Tools Filter

Class | Alias | Property |
Senver Device

Tango Device Installation Wizard on tangobox:10000

e

Server Registration

This wizard helps you to install a Tango device. First,
you have to enter the "Server name" (executable file

i}
cl

A

&
=3

i}
cl

AR RRARR]
e

E' o name) and its "instance name".
N To register the server, click [Mext].
=5 T

Sl

Server name empearaturesensor
Instance name |mtsi -
Back Mext = Cancel
Refresh

Click Next.
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Tango Device Installation Wizard on tangobox:10000

Start the server

The server "MyTemperatureSensor/mtsi® has been
successfully registered. You have to start it now.
When done, click [Next] to continue or [Back)] to
register a new server,

= Back MNext = Cancel

Now is the right time to start our server:

In the terminal windows, run the device server with an instance, msti, in this
case:

| ./MyTemperatureSensor mtsi

In Jive, click next on Start the server screen
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Tango Device Installation Wizard on tangobox:10000

Class Selection

k* The server has been succesfully started and has 1
classies) . Keep in mind that modifying exiting class
property may affect ather running server,

Click [Edit Class] to edit properties of the selected
' class
Click [Declare device] to continue with device
Arnlaratine
5erver: MyTemperatureSensor
MyTemperatures

ensor/mtsi

= Back Edit Class Declare device Cancel

To instantiate a device, we need to select its Class type. In this case there is just
one Class type in our Device Server (but remember there can be more). Select
MyTemperaturSensor and click Declare Device.

Tango Device Installation Wizard on tangobox:10000

Device Declaration of Class "MyTemp...

It is now time to give a device name for the
'MyTemperatureSensor' class. If this device does not

already exit, it will be added. Otherwise, the server's
device list remains unchanged.
Click [MNext] to edit device properties.

Device name simftemp/l -

= Baclk Mewt = Cancel

1. Enter device name: sim/temp/1

Note: for the purpose of this demo you could any string consisting of 3 fields,
separated by slashes. The aim of this naming system for big real-world systems is
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to allow you to construct a logical domain/family/member hierarchy of Devices
that is fully independent of the physical Device Server Layout.

2. Click Next
3. Finish

4. Click Yes on "Would you like to reinitialize the server?"

MyTemperatureSensor now appears in list of device servers in Jive. Right click on
Temperature and select Monitor Device. Temperature is 0 as expected, we declared
an attribute but did not implement anything that would change its value

Jive 4.24 [tangobox:10000]
File Edit Tools Filter

Class | alias [ Property | || Device Info
Server I Device | i/ Device Info -----oooooeooooooooo oo
o % DataBaseds Device: sim/temp/l
.S % LimacChs i type_id: IDL:Tango/Device_4:1.0
o % MacroServer liop_wersion: 1.2 _
? ;JE‘;I_, MyTemperatureSensor host tangobox.local (192.165.149,.132)
T - | {port: 42191
¢ = mtsi i |server: MyTemperatureSensor/mtsi
¢ &l MyTemperatureSensor | |server PID: 7858
¢ & [sim/temp/1]| || |Exported: true
o= E:I Froperties Last_exported: 2nd July 2013 at 09:57:57

@Pguing || Last_unexported: ?

B Event : )

By Attribute config i Petling Status ---------oooooooooooooooeoon oo oo

o [y attribute properties :
Logaging

o % Pool
o % PySignalSimulator
o= & SimMotor
o % Starter
o % TangoAccessControl
o % TangoTest

Refresh

Figure 11: Device server MyTemperatureSensor has a device class sim/temp/1

We can now modify the code to introduce some changes to the temperature and
make the demo meaningful.

Before we change the code, stop the device server (Ctrl-z in the terminal where it
is running).



TANGA.

Connec ting things together

Pag

For the purpose of this demo you can keep using make and
simple text editing: just navigate to the source files with Files
Note and edit them with right-click>Open With->GNU Emacs.

If you prefer you can skip the section on Eclipse
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Launch eclipse.

File>Import->Existing Code as Makefile Project

Select o
Creates a new Makefile project in a directory containing existing code E:ﬂ

Select animport source:
[ =

> (= General
¥ = C/C++
[E] ¢/C++ Executable
&% C/C++ Project Settings
Existing Code as Makefile Project
> & CVS
> = Git
> = Install
> (= Maven

® < Back [ Next > J Cancel Finish

Browse to MyTemperatureSensor, just select the top directory and OK.

Select Linux GCC as Toolchain and Finish

Window—->Open Perspective>C/C++ and things should look like this:

File Edit

NP O @S T

¥ <4Plug-in Development ¢ PyDev %% Debug | ERic/c++|

25 Project Explorer 2 = O & MyTemperatureSensor.h = L For M = g

=R - Lo} b PROTECTED REGION ID(MyTemperatureSensor.h) ENABLED START -- [-/M AR e w w
» & pytest # MYTEMPERATURESI
R ———— #ifndef MYTEMPERATURESENSOR H I 2 tngon

Lt #define MYTEMPERATURESENSOR H
» 3 Binaries = ¥ @ MyTemperatureSen

> il Includes ¥ @ MyTemperatureSe
2|  #include <tango.h=

» = bin L] Z o attr_Temperatur
* zobj FARREEE PROTECTED REGION END ----- */ = @ MyTemperature!
> (g ClassFactory.cpp @ MyTemperature!
> (¢ main.cpp s pex @ MyTemperature!
> [g MyTemperatureSensor.cpp * MyTemperatureSensor class Description: = @ ~MyTemperatur:
*  MyTemperatureSensor = e delete _device():
¥ (¢ MyTemperatureSensorClass.cpf 4 @ init_device():vo
* [0 MyTemperatureSensorClass.h - namespace MyTemperatureSensor ns o always_executec
» [g MyTemperatureSensorStateMac 2 ey @ read_attr_hardw
[ Makefile f¥--on- PROTECTED REGION ID(MyTemperatureSensor::Additional (l? - B -
[E Makefile.bck
[¥] MyTemperatureSensor.xmi Bi Problems 22 ¥ Tasks El Console Properties s |

9 errors, 1 warning, 0 others
Description Resource Path Location Type
» @ Errors (9items) | |

v v

[W /MyTemperatureSensor/MyTemperatureSensor.h
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1. In the MyTemperatureSensor.cpp file

a. Add initialization code in void
MyTemperatureSensor::init_device()

Existing Code New Code

// Initialize device // Initialize device
set state(Tango::0N) ;
*attr Temperature read = 5;

b. Set the variable to increase in
void
MyTemperatureSensor::read_Temperature(Tango::Attribute
&attr)

Existing Code New Code

*attr Temperature read += 1;

// Set the attribute value // Set the attribute value
attr.set value(attr Temperature read) ; attr.set value (attr Temperature read);

2. Project>Build project or make in terminal
3. Restart device server

4. In Jive, monitor device to confirm that the temperature changes
(increases).

5. With AtkMoni you can visualize the linear temperature increase.
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File Edit Source Refa

e v B R v

5 Project Explorer = &
B % M
> 4 pytest
¥ S MyTempProject
* lincludes
* &bin
» = obj
» [& ClassFactory.cpp
» [& main.cpp
» [ MyTemperatureSensor.cpp
» i MyTemperatureSensor.h
» (¢ MyTemperatureSensorclass.cpp
» [ MyTemperatureSensorclass.h
» [g MyTemperatureSensorStateMac
[ Makefile
[¥] MyTemperatureSensor.xmi
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) TETE NI BErO T EE Y *SNNY #
Q ! B  4-PluginDevelopment € PyDev % Debug | B c/ct+|
O MyTemperaturesensor.cpp 32 emperatureSe = g %o % @ T = |

* Read Temperature attribute
Description: a

DevDouble

* Data type: Tango:
* Attr type: Scalar

DEBUG_STREAM << "MyTemperatureSensor:: read_Temperature (Tango: :Attribute &

/el et PROTECTED REGION ID(MyTemperatureSensor::read_Temperature) ENABLE| =

- ¥ 3 Trend
// Set the attribute value ¢ sim/temp/1
attr Temperature read += 1; [1] Temperature

attr.set_value(&attr_Temperature_read); 498

r* - PROTECTED REGION END

*/  // MyTemperatureSensor::read_Tem

Problems & Tasks [ Cansole 52 | [ Properties o og @

DT Build Console [MyTempProject]

09:53:01 **** Incremental Build of configuration Default for project MyTempProject #
make all

Creating directories ./bin/

Linking TANGO device server ./bin//MyTemperatureSensor ...

g++ ./obj/MyTemperatureSensor.o ./obj/MyTemperatureSensorClass.o ./obj/MyTemperature
ClassFactory.o ./obj/main.o -L/usr/local/lib -1ltango -llog4tange -L/usr/loecal/
1omniORB4 -lowniDynamic4 -lomnithread -lzmq -1dl -lpthread -lstdcs+ -o ./bin//MyTemp TR RCICCRE WRRWCh | BRI AR
Temperature (1)

©9:53:02 Build Finished (took 894ms)

[5 /MyTempProject/MyTemperaturesensor.h

Figure 12: Temperature is seen to increase
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Historical DataBase: HDB++

TANGO offers 2 Historical Databases for archiving device attributes in a control
system. The latest solution is called HDB++. It uses the events mechanism in
device servers to trigger so-called “archive” events. These are gathered by
archive event subscribers who listen for events and store them in the database.
Two databases backends are implemented - a MySQL and a Cassandra one. The
virtual machine has HDB++ installed for MySQL. It is pre-configured to read and
stored 5 attributes. Two devices servers are running in the background and two
graphical applications are provided via the launcher - hdb_config and hdb_viewer.

To start hdb_config click on the icon in the launcher. You will see a graphical
window similar to this:

Ubuntu Desktop 1y B = ) 1231

(060 wancomtins 22 risgpsemmecesrios = g

Eile View Tools help pw = tango

i iber: [tango:/it; 9-vm:10000/archivi iber.01 |~

(?E)‘ HDB++ Configurator

S Started Attributes | 0 Paused Attributes | 0 Stopped Attributes |

Filter tango:// [#/*/4#+ 13 README
| |l +] o) G :
1000/sim/motor/1/positi
000/sys/tg_test/1/doul
000/sys/tg_test/1/floal
tango:/ftango9-vm:10000/sys/tg_test/1/long_scalar
tango:/tango9-vm:10000/sys/tg_test/1/wave

& & LimaCCDs

& & Macroserver
o & mntgrp

o & motor

HEImBE

& <& PySignalSimulator
¢ @ sim

s
L
~
7
*

[@l| Connecting things together
ROop@PaEwm@d @G Right Ctrl

The TANGO device tree on the left can be used to select attributes and configure
them for archiving. For events to work the device in question has to have polling
configured or be capable of pushing events.
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To view archived data from HDB++ start the hdb_viewer tool from the launcher to
select which attributes to view and for which period:

[

user = tango-cs
File view pw = tango
(HDE Tree] -0 : Chart} Table} mage] =1E3
7 Stangodvm:10000
¢ Esim
¢ S motor
P&
(84 position 150

README

+Esys
¢ Etg_test
. 1
2 double_scalar 100
3 float_scalar
£2) long_scalar

wave

W8 Semch
=i
start [1L/10/2005 11:40:14 [

150

stop  [11/10/2005 12:40:14 [
Last 1 hour -

12:15:00 12:20.00 12:25:00 12:30.00
simymotor/1/position (Y1) sysftg_test/1/double_scalar (Y1)
sys/tg_test/1/long_scalar (Y1)

12:35.00 12:40:00
sys/tg_test/1/float_scalar (Y1}

Show legend [[] Show grid  [] Clickable error only [] View Errors

Selection a
Tango Host Attribute Type Records Table | Step | Sel.Yl | Sel.¥2 | Sel.img
angog-vm: Alposition scalar_double_rw_[158 (Err=0) v -

: position_w scalar_double_rw [158 (Err=0) g [~ g ™ E
3 sysitq_test/1/double_scalar scalar_double_rw v =
-vm: sysitg_test/1/double_scalar w scalar_double_rw
angog-vm: sys/tq_test/1/float_scalar scalar_float_rw 2 =
Pythan script

Saiecion
[ . ] [ oad || save | memove || clear all [[aiv1 [[allva |

=] Connecting things together

Bop@Paad @ BRight Ctrl
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Tips and Tricks

The Tango Box image is configure with persistent storage on, changes you make
are saved. When you shut down and restart, you continue where you left off,
useful when you use it for development purposes. | you intend to use the Tango
Box for demonstrations, you might want to start from the exact same image
every time again, to avoid the notorious "demo effect".

The way to do this is to add this line to the scsi0 section of the .vmx file:
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